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Vorbemerkungen

• Die vorliegende Dokumentation gilt dem Erstanwender von OrCAD PSpice. Sie soll weder als 

Trainingshandbuch noch als vollständige Bedienungsanleitung verstanden werden. Dieser 

Schnellstart kann mit der OrCAD Trial Version durchgeführt werden.

• Es werden Grundlagen von elektronischem Schaltungsentwurf vorausgesetzt.

• Aufgrund der Kompaktheit dieser Dokumentation kann nicht auf alle verfügbaren Feinheiten und 

Befehle eingegangen werden. Hierzu ist eine umfangreiche Dokumentation innerhalb der Online-Hilfe 

(Help > PSpice Documentation) vorhanden. 

• Anhand eines einfachen Schaltplans werden die wichtigsten Schritte und Arbeitsweisen mit der 

Software dargestellt, die es dem Erstanwender erlauben, mit einem Minimalaufwand an 

Einarbeitungszeit die ersten eigenen Aufgaben zu bewältigen.

• Nach einer kurzen Einführung in die Benutzeroberfläche und zu den verschiedenen Analysearten 

beginnt das Training mit der Eingabe des Schaltplans ab Seite 33.

• Entpacken Sie das Archiv PSpice_Demo.zip in einen beliebigen Ordner und starten Sie die 

installierte OrCAD Capture Software.

• Zur besseren Lesbarkeit wurde für diese Anleitung das Light Theme der Software gewählt, obwohl 

seit OrCAD Version 17.4 Dark Theme Grundeinstellung ist. Man kann leicht zwischen dem hellen und 

dunklen Erscheinungsbild wechseln.
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Einführung



5FlowCAD Confidential  │

Systemvoraussetzungen

Betriebssystem Windows 10 (64-bit) Professional, incl Dark Theme mode;

Windows 2012 Server (All Service Packs); Windows 2012 R2

Windows 2016 Server

Empfohlene Hardware Intel Core™ i7 4.30 GHz oder AMD Ryzen™ 7 4.30 GHz mit

mindestens 4 Kernen

16 GB Arbeitsspeicher (RAM)

50 GB freier Festplattenspeicher (SSD empfohlen)

1920 x 1200 Pixel Bildschirmauflösung mit true color 32-bit Farbtiefe 

Eine separate Grafikkarte mit mind. 2 GB Grafikspeicher OpenGL und 

DX11 Unterstützung für 3D Anwendungen

Breitband Internet Verbindung

Generell Die oben genannten Angaben zu Hardware sind als Mindestanforderungen 

zu verstehen. Je nach gestellter Aufgabe muss die Hardware entsprechend

„nach oben“ angepasst werden. PSpice nutzt das Vorhandensein von

mehreren Prozessorkernen zur Simulation aus. 
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Installation und Einstellungen

• OrCAD Trial beinhaltet die Vollversion von PSpice A/D und PSpice Advanced Analysis.

• Die Trial Version kann von www.orcad.com heruntergeladen werden. Nach erfolgreicher Registrierung 

erhält man einen Link zum Download und eine Anleitung zur Installation.

• Eine ausführliche Anleitung Quickstart PSpice 17.4 Trial findet man unter  

https://www.flowcad.com/de/download.htm.

In OrCAD Capture CIS und/oder OrCAD PSpice Designer können eine Vielzahl von persönlichen 

Einstellungen (Produktkonfigurationen, Schaltplanvorlagen, Farbschemata usw.) vorgenommen werden. 

Diese Möglichkeiten werden in diesem Dokument nicht behandelt, weil sie weit über den Zweck der 

Dokumentation hinausgehen. Solche Einstellungen werden in speziellen Konfigurationsdateien (.ini) 

gespeichert.

Mehr zur Individualisierung des Front End Tools OrCAD Capture finden Sie im Quickstart zu Capture.

http://www.orcad.com/
https://www.flowcad.com/de/download.htm
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Grundlegende Bedienungshinweise 
für Capture / PSpice 
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Bedienkonzept, Sonderzeichen

OrCAD Capture und PSpice sind menügesteuerte Programme.

Die überwiegende Anzahl der Kommandos oder Eingaben werden gesteuert über:

• Aktionsmenüs (pull-down menu)

• Piktogramme (icons)

• Tastenkürzel (shortcuts)

• Dialogfenster (pop-up windows)

• Kommandozeilen Fenster

• Tcl Funktionen

Grundsätzlich werden in OrCAD / PSpice kontextabhängige Menüs verwendet, d.h. je nach 

ausgewähltem Element, Arbeitsbereich oder Kommando ändert sich das Erscheinungsbild der 

zugehörigen Dialogfenster und Aktionsmenüs so, dass nur die für das ausgewählte Element relevanten 

Funktionen und Objekte dargestellt werden (Fokussierung).

Es gelten Einschränkungen bei der Verwendung von Sonderzeichen in vielen Namen für Objekte, 

Projektnamen und Verzeichnissen. Als sicheres Zeichen zum Trennen gilt der Unterstrich ( _ ). 

Verwenden Sie keine Leerzeichen in Namen!
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Wichtige Dateinamenerweiterungen in PSpice

Im Laufe eines Projektes entstehen viele Dateien. Hier ein Überblick über die wichtigsten 

Dateinamenerweiterungen:

.OPJ OrCAD Capture Projekt Datei

.DSN OrCAD Capture Design Datei

.DBK Design Sicherungskopie

.OLB Capture / PSpice Symbol Bibliothek

.LIB PSpice Modell Bibliothek

.DAT Probe Datei

.OUT PSpice Ausgabedatei

.SIM Simulationsprofil

.NET PSpice Netzliste

.PRB Probe Konfigurationsdatei

.STL Stimuli Datei

.CIR PSpice Schaltungsdatei
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Projekte Kopieren / Archivieren in PSpice

• Das Kommando Archivieren speichert das 

Projekt und alle dazugehörigen Dateien und 

Bibliotheken: Dazu erst die Capture Design 

Datei im Projektmanager selektieren 

(<design>.dsn). Dann File > Archive Project 

… auswählen.

Das Ziel kann ein neues Verzeichnis oder ein 

ZIP Archiv sein.

• Manuelles Kopieren

− .opj

− .dsn

− .stl

− .sim

− .lib

Alle anderen Dateien werden beim Generieren 

von Netzlisten oder Simulieren automatisch 

wieder erzeugt.
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Einheiten, Größen, Präfixe in PSpice

PSpice rechnet nur mit Zahlenwerten und nicht 

mit Einheiten!

Folgende Präfixe werden erkannt:

1f (femto-) = 1 x 10-15

1p (pico-) = 1 x 10-12

1n (nano-) = 1 x 10-9

1u (micro-) = 1 x 10-6

1mil (mil) = 2.54 x 10-5

1m (milli-) = 1 x 10-3

1K (kilo-) = 1 x 103

1Meg (mega-) = 1 x 106

1G (giga-) = 1 x 109

1T (tera-) = 1 x 1012

Tipp

• Einheiten (Ohm, Volt, Farad, Henry…) dienen 

ausschließlich der Lesbarkeit.

• PSpice liest den Zahlenwert einschließlich 

Präfix. Alles danach wird ignoriert 

(Kommentar).

1KOhm = 1K = 1000

Achtung

• PSpice unterscheidet nicht zwischen Groß-

und Kleinschreibung. D.h.

1M = 1m = 0.001 milli (nicht Mega)

• 1 x 106 = 1Meg = 1MEG = 1meg
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Schaltungsbeispiel (I)

• Ziel dieser Anleitung ist die Simulation einer vollständigen Schaltung. Als Beispiel dient ein 

Schaltnetzteil (Switched Mode Power Supply, SMPS). Diese besteht aus einer Quelle mit 

Gleichrichter, einer PWM-Steuerung, einem Trafo, einem Tiefpass Filter und einer Last.*

• Im beigefügten Archiv zum Schnellstart gibt es einen Ordner Solution, der die Schaltung und alle 

Simulationskonfigurationen enthält. Diese Lösung benutzt Symbole nach der europäischen IEC Norm. 

Diese Symbole werden in einer Symbol Bibliothek (Europe.olb) zur Verfügung gestellt.

• Sinn und Zweck des Schnellstarts ist, dass die Schaltung und alle Konfigurationen selbst eingegeben 

werden. Denn: Übung macht den Meister.

• Die nächsten Seiten geben einen Überblick über die notwendigen Aktionen zur Erstellung der 

Schaltung von Grund auf.

* und der obligatorischen Simulationsbezugsmasse „0“ 
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Schaltungsbeispiel (II)

Amerikanische Symbole
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Schaltungsbeispiel (III)

Europäische Symbole
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Starten einer PSpice Simulation

Es gibt zwei Möglichkeiten eine PSpice Simulation zu starten:

• Indirekter Start über OrCAD Capture:

− Start > OrCAD Trial 17.4-2019 > Capture CIS 17.4

− Dieses ist die bevorzugte Methode um die Simulation zu starten: Zunächst wird der Schaltplan 

erstellt, dann ein Simulationsprofil konfiguriert, um dann aus der Capture Umgebung die PSpice 

Simulation mittels eines Klicks auf Run PSpice zu starten. Das Erstellen der Netzliste übernimmt 

das Programm im Hintergrund.

• Direkter Start von PSpice:

− Start > OrCAD Trial 17.4-2019 > PSpice AD 17.4

− PSpice verlangt eine Netzliste <*.net> und eine Schaltungsdatei <*.cir> der zu simulierenden 

Schaltung

• Starten Sie Capture CIS.
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Starten von Capture

• Die Startseite von Capture zeigt nützliche Informationen, z. B. die Projekte mit denen Sie zuletzt 

gearbeitet haben.

• Ein bereits bestehendes Projekt wird mit File > Open > Project geöffnet (oder ggf. durch Anklicken 

des Projekts auf der Startseite).

• Tipp

− Es stehen viele Demoprojekte zur Verfügung, die mit File > Open > Demo Designs geöffnet 

werden können.

− Zum Schließen im Projektmanager das <x.dsn> selektieren, dann auf File > Close klicken.

Project Manager

LMB

1. 2.
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Ein neues PSpice Projekt anlegen

• File > New > Projekt öffnet den Dialog zum 

Anlegen eines neuen Projekts.

• Im Feld Name wird der Name des neu 

anzulegenden Projekts eingegeben. 

Geben Sie SMPS ein.

• Das Feld Location zeigt das Verzeichnis, in 

dem das Projekt gespeichert wird. Mit einem 

Klick auf       kann man das Verzeichnis über 

einen Browser auswählen. Alle Daten für das 

Simulationsprojekt werden hier gespeichert. 

• Für ein PSpice Projekt muss der Haken bei 

Enable PSpice Simulation gesetzt sein.

• Mit OK öffnet sich ein Fenster, welches es 

ermöglicht ein neues Projekt aus einem 

bestehenden zu generieren. Wir starten mit 

einem leeren (blank) Projekt.

• OK legt das Projekt an.
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Projekt SMPS

• Sie haben ein neues Projekt (smps.opj) mit dem Namen SMPS angelegt. In dem Projekt befindet sich 

das Design smps.dsn.

• Gleichzeitig hat sich die erste Seite (PAGE1) des Schaltplans geöffnet. Unten rechts erscheint das 

Beschriftungsfeld. Diese Einstellungen sind konfigurierbar.

• Im Projekt Manager links sehen Sie eine virtuelle Ordnerstruktur (d. h. diese ist nur im .dsn file

abgebildet, nicht im Dateisystem).

• Auf der rechten Seite erscheinen Piktogramme zum Platzieren und Verdrahten.

Auf den folgenden Seiten 

werden notwendige Schritte 

erläutert, die Sie später 

bei der Erstellung der 

Schaltung benötigen.
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Bauteilsuche mit PSpice Part Search

• Mit Place > PSpice Component > Search öffnet sich das PSpice Part 

Search Fenster.

• Hier kann man Bauteile nach ausgewählten oder allen Kategorien 

sowie in angelegten Bibliotheken suchen. Es erlaubt die Eigenschaften 

von vielen Komponenten auf einen Blick zu vergleichen, um so die 

gewünschte Komponente direkt auszuwählen. Die so selektierte 

Komponente kann direkt in den Schaltplan eingefügt werden.

• Die hier aufgeführten Bauteile sind in einer PSpice Part Search

Datenbank gespeichert, die zentral oder dezentral verwaltet werden 

kann. So könnten Nutzer global auf eine zentrale Bauteildatenbank 

zugreifen.

• Der Bestand der Datenbank im Auslieferungszustand entspricht den 

Standardbauteilen, die von Cadence mit der Software ausgeliefert 

werden. 

• Bauteile können zur Datenbank hinzugefügt werden; 

die Vorgehensweise ist nicht Bestandteil des Schnellstarts.

Tipp

Man kennt das Bauteil, weiß aber nicht in welcher Bibliothek es sich 

befindet, dann ist der Browser die Lösung!
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Platzieren von Komponenten / Bauteilen

Um Bauteile zu platzieren gibt es 

alternativ folgende Möglichkeiten:

• Place > Part  von der Menüleiste

• P auf der Tastatur drücken

• Piktogramm        (rechts)

Tipp 1

• Damit die Piktogramme aktiviert 

werden, muss eine 

Schaltplanseite geöffnet und 

aktiv sein.

Tipp 2

• Um eine automatische 

Annotation der platzierten 

Komponenten zu gewährleisten, 

sollte man unter Options > 

Preferences Miscellaneous

den Haken bei Automatically

reference placed parts gesetzt 

haben.
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Symbolbibliotheken, Auswahl von Bauteilen

Im Place > Part Modus erscheint das Place Part Fenster auf der rechten Seite. 

Sobald man eine oder mehrere Bibliotheken im Libraries Fenster selektiert, 

erscheinen deren Bauteile in der Part List. Die Eingabemaske Part dient als 

Filter um die Auswahl einzuschränken. Sobald man genau ein Bauteil in der 

Part List selektiert hat, kann man es mit       ,<Eingabe> oder einem 

Doppelklick im Schaltplan platzieren.

Mit       (Add Library) fügt man Bibliotheken in den Suchpfad ein. Die Standard 

Bibliotheken mit Cadence PSpice Symbolen befinden sich unter:

<installation_dir>\tools\capture\library\pspice

<installation_dir>\tools\capture\library\pspice\advanls

Die Standardbibliotheken sind in <installation_dir>\tools\bin\pspice.ini 

aufgeführt und stehen allen Projekten zur Verfügung.

Der Abschnitt Packaging zeigt, ob ein ausgewähltes Bauteil aus mehreren 

Teilen besteht, z. B. ein Widerstandsnetzwerk oder wie der hier gezeigte 

Operationsverstärker.

Die beiden Piktogramme          zeigen an, ob zu dem ausgewählten Bauteil ein 

PSpice Modell und / oder ein PCB Footprint zugeordnet ist.

Um ein Bauteil in allen konfigurierten Bibliotheken zu suchen, kann man dieses 

(auch mit Platzhaltern) in der Search for Part Maske eingeben. Anschließend 

fügt man die entsprechende Bibliothek mit dem Knopf Add in den Suchpfad 

ein.
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Bauteile Verdrahten

Nachdem die Bauteile im Schaltplan platziert sind, 

müssen sie verdrahtet werden. Das Verdrahten 

wird gestartet mit

• Place > Wire

• W (Tastatur)

• Place Wire Piktogramm

Um z. B. erklärenden Text im Schaltplan 

einzufügen benutzt man

• Place > Text

• T (Tastatur)

• Place Text Piktogramm
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Bauteileigenschaften im Schaltplan Editieren

Gleichzeitiges Editieren von REFDES und Value

• Erst: Selektieren des Bauteils oder der Bauteile. 

Dann: Rechte Maustaste > Edit Properties 

Jetzt die entsprechenden Eigenschaften im 

Property Editor bearbeiten.

• Um alle Bauteile gleichzeitig zu bearbeiten, 

selektiert man im Projektmanager das <*.dsn> 

Design, dann mit der rechten Maustaste Edit 

Object Properties auswählen.

Tipp

Um mehrere Bauteile zu selektieren, drücken und 

halten sie die <STRG> Taste und klicken 

nacheinander auf die Bauteile, die sie selektieren 

wollen.

Nur REFDES oder Value editieren

• Erst: Selektieren der angezeigten Eigenschaft, 

die man ändern möchte. Dann: Rechte 

Maustaste > Edit Properties oder Doppelklick 

auf die zu ändernde Eigenschaft.

• Das Display Properties Fenster öffnet sich. 

Hier können sowohl der ausgewählte Wert als 

auch Eigenschaften über die Sichtbarkeit im 

Schaltplan ausgewählt werden.
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Schaltplan Editieren: Netz Alias

• Jede neue Leitung bekommt einen vom 

System generierten eindeutigen Netznamen.

• Den systemgenerierten Namen kann man 

durch einen Netz Alias (Net Alias) ersetzen.

• Auf einem Schaltplanblatt ist ein Netz mit 

einem Alias verbunden mit allen Netzen, 

Konnektoren, oder hierarchischen Verbindern 

mit dem gleichen Namen.

− Man kann so mehrere Anschlüsse beliebiger 

Bauteile auf dem Schaltplanblatt miteinander 

verbinden, indem man einen Anschluss mit 

einem Leitungsstücke verbindet und dieses 

dann mit einem Netz Alias versieht. Dazu 

muss keine physikalische Verbindung 

zwischen den einzelnen Leitungsstücken 

bestehen (Wireless Connection).

• Place > Net Alias

• Place Net Alias Piktogramm

Tipp

Um Netze über mehrere Schaltplanblätter oder 

sogar Design-Hierarchien miteinander zu verbinden, 

müssen Konnektoren (Off-Page Connector) oder 

Verbinder (Hierarchical Port) verwendet werden!

Knotenpunkt 

Bus

Netz Alias Wireless Connection
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Tipps für die Simulation

Für die erfolgreiche Simulation einer mit Capture erstellten Schaltung sollte man folgende Dinge 

beachten:

1. Alle Bauteilsymbole müssen ein PSpice Modell besitzen, also aus einer PSpice Bibliothek kommen. 

Ein klassischer Fehler ist z. B. einen Widerstand aus der Capture Bibliothek discretes.olb ohne 

PSpice Modell im Schaltplan einzusetzen, statt den aus der analog.olb zu verwenden. 

Standard PSpice Libraries befinden sich:

<$CDSROOT>\tools\capture\library\pspice oder

<$CDSROOT>\tools\capture\library\pspice\advanls

2. Jede Schaltung muss ein Referenzpotential aufweisen, üblicherweise durch das Massesymbol 

gekennzeichnet. Dieses muss den Wert „0“ haben.

3. Größere Schaltungen sollte man in kleinere Unterblöcke zerteilen, um ggf. Fehler besser einkreisen 

zu können.

4. Sich vor jeder Simulation darüber im Klaren sein, was man als Simulationsergebnis erwartet 

(Für Interessierte: Apply Rule #9, Quelle: Signal Integrity Journal).

https://www.signalintegrityjournal.com/blogs/4-eric-bogatin-signal-integrity-journal-technical-editor/post/1539-bogatins-20-rules-for-engineers
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Die verschiedenen Simulationstypen
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Die verschiedenen Simulationstypen in PSpice

In PSpice sind vier grundlegende Simulations- (oder Analyse-) Typen möglich. Die erforderlichen 

Analyseparameter werden in den Simulationsprofilen innerhalb eines Projekts definiert und 

gespeichert. Auf den nächsten Seiten werden alle vier Typen vorgestellt. 

Im mitgelieferten Archiv befinden sich unter Solution / Samples die entsprechenden Beispiele.

• Arbeitspunktanalyse (Bias Point)

− Spannungen und Ströme im Arbeitspunkt

• DC Sweep

− Viele Gleichstromanalysen mit veränderten Parametern

• Simulation im Zeitbereich, Transientenanalyse (Time Domain, Transient)

− Untersuchung zeitabhängiger elektrischer Vorgänge

• Frequenzgänge (AC Sweep)

− Analyse der Frequenzabhängigkeit von Strömen und Spannungen (Amplitude und Phase)
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Arbeitspunktanalyse (Bias Point)

In dieser Simulation berechnet PSpice die 

Spannungen (Knotenpotentiale) und Ströme der 

Schaltung im Arbeitspunkt. Das Potential bezieht 

sich auf die Simulationsmasse (platziertes Masse-

Symbol „0“ in der Schaltung).

• Die Spannungen, Ströme oder Leistungen 

kann man nach der Simulation durch PSpice > 

Bias Points > Enable oder durch die 

Verwendung der Piktogramme

im Schematic sichtbar machen.

• Varianten der Arbeitspunktanalyse

− Kleinsignal Übertragungsfunktion

− Empfindlichkeitsanalyse

Beispiel

− Projekt bias_point.opj im Ordner 

Solution\Samples\bias_point\
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DC Sweep

• Um z. B. eine Kennlinie eines Bauelements zu 

ermitteln, muss man viele Arbeitspunkte berechnen. 

Die DC Sweep Analyse variiert eine Schaltungsgröße 

(Strom- oder Spannungsquellen, Schaltungs- oder 

Modellparameter oder Temperatur) und führt eine 

Reihe von Gleichstromanalysen durch.

• Das Ergebnis kann man sich im Probe Fenster oder 

in der Simulationsausgabedatei anschauen.

Beispiel

• DC_Sweep.opj im Verzeichnis Solution\Samples\

DC_Sweep. Hier wird die Spannung der 

Spannungsquelle von 0-10V in 1V Schritten simuliert.
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Analyse im Zeitbereich (Transienten-Analyse)

• Um die zeitliche Abhängigkeit von elektrischen 

Prozessen zu untersuchen, verwendet man im 

Zusammenhang mit realen Schaltungen ein 

Oszilloskop. Der Aufbau mit spezifischer Hardware 

bildet nur begrenzte Untersuchungsmöglichkeiten.

• Deutlich einfacher und günstiger ist eine 

Transienten-Analyse mit PSpice. Die Simulation 

löst die entsprechenden Differentialgleichungen im 

Zeitbereich und stellt die Ergebnisse mittels Probe

grafisch dar (Software Oszilloskop).

Beispiel

• Das Projekt time_domain.opj im Verzeichnis 

Solution\Samples\time_domain.

Hier werden die Ströme und Spannungen beim 

Lade- und Entladevorgang eines Kondensators 

betrachtet.

Tipp

• Farben kann man mittels Tools > Options in der 

Color Settings Mappe individuell anpassen.

Der Kondensator C1 wird über einen 

Widerstand R1 mittels einer 

Pulsspannungsquelle periodisch ge-

und entladen.
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Frequenzgang (AC Sweep)

• Die Wechselstromanalyse berechnet das 

Kleinsignalverhalten (also Amplituden und Phasen von 

Spannungen oder Strömen um den Arbeitspunkt herum) 

einer linearen oder linearisierten Schaltung als Funktion 

der Frequenz. Die Schaltung kann dabei aus linearen 

Komponenten (RLC) und / oder aus nichtlinearen 

Bauteilen (Transistoren, Dioden, …) bestehen. Diese 

werden um den Arbeitspunkt herum linearisiert.

• Die Simulation erfolgt durch eine Vielzahl von einzelnen 

AC Analysen bei unterschiedlichen Frequenzen.

Beispiel

• Projekt „AC_Sweep.opj“ im Ordner 

„Solution\Samples\AC_Sweep\“
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Weitere Analysen

• Ohne dass in diesem Schnellstart näher darauf eingegangen wird, sind mit PSpice weitere Analysen 

möglich, z. B.

− Fourieranalyse (Spektralanalyse) als Teil einer Transienten-Analyse.

− Temperatur-Sweep: Das Schaltungsverhalten bei unterschiedlichen Temperaturen simulieren.

− Monte-Carlo Analyse: Die Simulation wird unter Berücksichtigung von Toleranzen der Bauteile 

durchgeführt und kann statistisch ausgewertet werden.

− Empfindlichkeitsanalyse: Zum Ermitteln der zulässigen Toleranzen.

− Rauschanalyse: Zur Bestimmung des Rauschabstands.

− Worst-Case Analyse: Dient der Bestimmung von funktionalen Grenzen der Schaltung.

− Digitale Analysen: Zum Simulieren von Digitalschaltungen.

• Im Schaltungsbeispiel später werden wir noch von der Parameter Analyse (Parametric Sweep) 

Gebrauch machen.

− Die Parameter Analyse ist eine Erweiterung der Möglichkeiten der Parametervariation auf die 

Transienten- und AC Sweep Analyse.
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Schaltungsbeispiel:
Schaltnetzteil, Switched Mode Power Supply
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Ziele

• Zunächst soll die Schaltung des Schaltnetzteils mittels Capture erstellt werden. Die Schaltung 

konvertiert eine 230 V / 50 Hz Eingangsspannung in eine konstante 5 V Gleichspannung. Statt einer 

integrierten Schaltung zur Steuerung der PWM, wird hier ein konstanter 333 kHz Spannungspuls mit 

20 % relativer Einschaltdauer zur Ansteuerung des MOSFETs verwendet.

• Nun werden unterschiedliche Simulationsprofile erstellt und die Ergebnisse der Simulation mittels 

Probe analysiert.

Tipp 1

• Zum Nachschauen befindet sich die vollständige Schaltung mit allen Simulationsprofilen auch im 

Ordner Solution\Demo_Proposed_Circuit.

Tipp 2

• Zum besseren Verständnis der Software wird empfohlen die Schaltung gemäß der Anleitung Schritt 

für Schritt selbst zu erstellen.
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SMPS Design (I)

• Sie haben bereits das SMPS Projekt angelegt. Falls nicht, finden Sie auf den Seiten 17 und 18 die 

Beschreibung zum Erstellen eines neuen Projekts.

• Öffnen Sie das eben generierte Projekt und geben Sie den auf der nächsten Seite dargestellten 

Schaltplan in OrCAD Capture ein.

• Schauen Sie sich gerne noch einmal die vorhergehenden Seiten an, wenn Sie nicht mehr wissen, wie 

man nach Bauteilen sucht, wie man die Verdrahtung durchführt oder wie man einzelne Werte von 

Bauteilen ändert.

• Achten Sie darauf, dass alle Bauteile die im Schaltplan spezifizierten Werte erhalten.

• Fügen Sie folgende Bibliotheken zum Projekt hinzu: Infineon.olb, irf.olb, magnetic.olb, PWRMOS.olb, 

source.olb, special.olb.

• Im entpackten ZIP Archiv finden Sie auch die Europe.olb wenn Sie europäische Symbole verwenden 

möchten.

Tipp 1

• Falls Sie amerikanische Symbole für R, L und C, dann nehmen Sie die analog.olb.

Tipp 2

• V1 ist eine Quelle vom Typ VPULSE, V2 ist VSIN.
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SMPS Design (II), Schaltplan
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SMPS Design (III)

Neu ist die Komponente Parameters, die die 

globalen Parameter D, LOAD, Periode und

Source definiert. Nachstehend wird gezeigt, wie 

man diese eingibt.

1. Platzieren Sie die Komponente param aus 

der special.olb Bibliothek. Mit einem 

Doppelklick darauf gelangen Sie in den 

Property Editor.

2. Hier gehen Sie auf New Property und fügen 

den neuen Parameter D hinzu. Genauso 

verfahren Sie mit allen anderen Parametern.

3. Schließen Sie das Property Editor Fenster, 

um zurück in den Schaltplan zu gelangen.

Tipp

Um auf z. B. globale Parameter als Werte für 

Komponenten zurückzugreifen, benutzt man 

geschweifte Klammern { }, die den Namen des 

Parameters umschließen. 
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SMPS Design (IV)

Wie definiert man den Transformator?

1. Platzieren Sie den Kern E13_6_6_3C81 aus der 

magnetic.olb Bibliothek und öffnen Sie den Parameter Editor 

mittels Doppelklick auf die Komponente.

2. Koppeln Sie die beiden Induktivitäten wie gezeigt (L1 = L1, 

L2 = L2).

3. Schließen Sie das Parameter Editor Fenster.

Tipp

Diese Komponente stellt einen nichtlinearen Transformator dar, 

der auf dem Jiles-Atherton Modell basiert. Die Werte der 

Induktivitäten entsprechen der Anzahl der Wicklungen auf der 

Primär-, bzw. Sekundärseite.
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Ein Simulationsprofil erstellen (I)

• Mittels PSpice > New Simulation Profile, 

oder einem Klick auf das Piktogramm  …  

erstellt man ein neues Simulationsprofil.

• Geben Sie Transient im Feld Name ein und 

klicken Sie auf Create.

Tipp

• Zu einem Projekt kann selbstverständlich mehr 

als ein Simulationsprofil erstellt werden.

• Um ein aktives Profil zu ändern, selektieren 

Sie PSpice > Edit > Simulation Profile oder 

klicken Sie auf       .
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Ein Simulationsprofil erstellen (II)

• Das Simulation Settings Fenster öffnet sich.

• Auf der linken Seite wählen Sie Analysis. 

Dann wählen Sie Time Domain (Transient) 

als Analysis Type aus. Unter Options den 

Haken bei General Settings setzen und 

rechts die Simulationsdauer (TSTOP) auf 

180 ms und die max. Step Size auf 1 ms

setzen.

• In Probe Window kann man das Verhalten 

der grafische Anzeige der 

Simulationsergebnisse beeinflussen.

Tipp

• Die Schrittweite wird während der Simulation 

dynamisch angepasst. Falls keine max. 

Schrittweite eingegeben wird, unterschreitet 

PSpice niemals den Wert von 2 % von TSTOP. 

Ein zu großer Wert der Schrittweite lässt die 

Kurven zu grob erscheinen. Ein zu geringer 

Wert hingegen erhöht die Simulationsdauer 

und das Datenaufkommen.   
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Starten der Simulation

• Nachdem das Simulationsprofil erstellt und gespeichert ist, kann man die Schaltung simulieren.

• Start mit: PSpice > Run oder auf …  drücken.

• Wenn Sie den Schaltplan so wie auf Seite 36 eingegeben haben, wird sich das Probe Fenster zwar 

öffnen, Sie werden aber keine Signale sehen. Sie haben noch keine Marker im Schaltplan gesetzt.

• Im Normalfall werden alle Daten über alle Knoten während der Simulation aufgezeichnet und stehen 

so später zur Verfügung.*

− Um die Kurven für einzelne Knoten nach der Simulation anzuzeigen, kann man entweder nach der 

Simulation Marker                     im Schaltplan setzen, oder

− man fügt im Probe Fenster mit Trace > Add Trace den Knoten hinzu, den man beobachten möchte.

Tipp 1

• Einen Spannungsmarker V setzt man auf ein Netz, einen Strommarker I auf einen Bauteil 

Anschluss und einen Leistungsmarker W auf das Bauteil selbst.

Tipp 2

• Je nach CPU Ihres Computers läuft die Simulation ca. 5 Minuten.

* Das Verhalten kann im Simulationssetup unter Data Collection eingestellt werden.
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Analyse (I): Gleichgerichtete Spannung

• Platzieren Sie, wie in der Abbildung, je einen 

Spannungsmarker links und rechts von der 

Spannungsquelle V2 und einen am Ausgang 

des Gleichrichters.

• Was sehen wir?

− Rot: Ausgangsspannung des Gleichrichters

− Grün: Positive Eingangswechselspannung 

− Lila: Negative Eingangswechselspannung

• Auswertung

− Die Wechselspannung wird über die Dioden 

gleichgerichtet. Der großzügig 

dimensionierte Kondensator C1 glättet die 

gleichgerichtete Spannung.

− Auf der nächsten Seite untersuchen wir die 

Ströme und Spannungen an C1.

Tipp

• Die Farbzuordnung findet nach einer 

vorgegebenen Reihenfolge in der pspice.ini 

Datei statt und hängt von der Reihenfolge der 

Vergabe der Marker ab.



43FlowCAD Confidential  │

Analyse (II): Strom und Spannung an C1

Der Plot zeigt den Strom / Spannungsverlauf am Kondensator C1. Man sieht alle 10 ms (100 Hz) die 

Stromspitzen beim Laden von C1 und einem hochfrequenten negativen Strom. Die Welligkeit der 

Ausgangsspannung hängt vom Kapazitätswert von C1 ab.

• Löschen Sie die vorherigen

Kurven durch Selektieren 

des Namens unterhalb der 

x-Achse. Drücken Sie dann

die Entf Taste.

• Trace > Add Trace oder

Wählen Sie V(L1:A).

• Plot > Add Y Axis

• Trace > Add Trace

Wählen Sie I(C1).

Tipp

In PSpice ein positiver Strom 

fließt von Pin 1 zu Pin 2.

Das erklärt die Vorzeichen

in diesem Fall.
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Analyse (III): Die HF-Signale 

Der MOSFET wird durch ein 330 kHz Signal periodisch ein- und ausgeschaltet. Über den Transformator 

bestehend aus L1 und L2 wird in L2 eine hochfrequente Wechselspannung induziert, deren Halbwellen 

abwechselnd durch die Dioden D5 oder D6 geleitet, und an der Spule L3 wieder zusammengeführt 

werden. Wir schauen uns die Ströme durch beide Dioden (blau und rot) und den zusammengesetzten 

Strom (gelb) durch die Spule L3 an.
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Analyse (IV): Der Tiefpassfilter

Der so erzeugte Strom durch L3 enthält noch hochfrequente Anteile, die mit Hilfe eines Tiefpassfilters 

eliminiert werden sollen. Wir analysieren dazu die Frequenzanteile vor und nach dem Tiefpass mittels 

Fourier-Analyse.

• Stellen Sie in zwei 

unterschiedlichen Fenstern 

die Spannungen z. B. an 

der Diode D5 und die 

Ausgangsspannung 

V(OUT) dar.

Tipp 1

• Plot > Add plot to Window

erzeugt einen 2. Plot.

Tipp 2

• Die Fourier Analyse kann 

mit Trace > Fourier oder 

mit dem Button       

berechnet werden.
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Analyse (V): Die Ausgangsspannung

Die Ausgangsspannung nähert sich oszillierend der Spannung von ca. 5 V an. Die geringe Restwelligkeit 

ist unter anderem dem großen Kondensator C1 und dem Tiefpassfilter zu verdanken.
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Parameter Analyse (I)

Bei der Parameter Analyse kann eine Schaltung 

mit verschiedenen Parametern (z. B. Werten für 

Komponenten) simuliert werden.

Die Schaltung ist schon für den Einsatz von 

Parametern vorbereitet. Nachstehend noch einmal 

die vier wichtigsten Schritte zusammengefasst:

• Definition der globalen Parameter

− Platzieren Sie das Symbol PARAM aus der 

special.olb auf dem Schaltplan. Es dient als 

Platzhalter für globale Parameter. Hier z. B. 

für den nominalen Widerstandswert von 

50 Ohm für R4

• Ersetzen des fixen Wertes einer 

Komponente mit dem Parameter

− Doppelklicken Sie auf den Wert der 

Komponente, welchen Sie durch einen 

Parameter ersetzen wollen. Dazu wird der 

Wert mit dem Namen des Parameters 

ersetzt und in geschweifte Klammern 

geschrieben {}.
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Parameter Analyse (II)

• Globale Parameter zuweisen und im 

Schaltplan anzeigen

− Doppelklick auf das Symbol PARAMETERS

um den Property Editor zu öffnen.

• Klick New Property um einen neuen 

Parameter zu generieren.

• LOAD, 50 in Name und Value eingeben.

• Apply generiert neuen Parameter.

• Cancel um das Fenster zu schließen.

• LOAD selektieren und auf Display

klicken. Das Display Properties Fenster 

öffnet sich.

• Display Name and Value auswählen.

• Wiederholen für die anderen Parameter 

D, Periode und Source.

• Nach OK sind sowohl die Parameter als 

auch die Werte im Schaltplan sichtbar.
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Parameter Analyse (III)

• Ein Simulationsprofil für die Parameter 

Analyse bearbeiten

− Editieren Sie das bestehende 

Simulationsprofil mit PSpice > Edit 

Simulation Profile (oder mit       ).

• Analyse Typ auf Time Domain setzen.

• Parametric Sweep auswählen.

• Als Sweep Variable Global parameter

wählen.

• Den Parameter Namen LOAD eingeben.

• Als Sweep Type Value List auswählen.

• In die Liste die Werte 10, 50 und 100

eingeben (mit Leerzeichen getrennt).

• OK zum Akzeptieren der Einstellungen.

− Starten der Simulation mit F11 oder      . 

− Die Simulation benötigt etwa 15 Minuten.

Nach der Simulation erscheint ein Auswahl-

Fenster. Alle Simulationen auswählen und 

mit OK bestätigen.
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Ergebnis der Parameter Analyse (I)

Gemäß der Auswahl der Simulationen im Auswahlfenster (All) erhalten Sie drei Kurven für die 

verschiedenen LOAD Werte.

Ergebnis

Man sieht, dass sich sowohl das zeitliche Verhalten als auch der Wert der Ausgangsspannung mit der 

Last ändert.

Tipp 1

Mit einem rechten Mausklick

und Trace Information erhält

man Auskunft über den

Parameter Wert.

Mit Plot > Transient erhält man

das Auswahlfenster wieder.

Tipp 2

Das Probe Cursor Fenster erhält 

man mit Trace > Cursor > Display

(oder mit      ).

In den Untermenüs finden 

Sie eine Vielzahl von 

Untersuchungsmöglichkeiten 

der Kurven.



51FlowCAD Confidential  │

Ergebnis der Parameter Analyse (II)

Probe erlaubt eine Vielzahl von Messungen an den dargestellten Kurven.

• View > Measurement Results oder ein Klick auf       öffnet das folgende Fenster unterhalb des 

Simulationsfensters (Fenster mit den Kurven):

• Ein Klick auf Click here to evaluate a new measurement öffnet ein neues Fenster. Wählen sie unter 

Measurements Max() und dann die Variable V(OUT).
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Ergebnis der Parameter Analyse (III)

• Die Maximalwerte der Spannungen aus den drei Simulationen werden angezeigt:

• Um Messungen an gleichen oder unterschiedlichen Kurven vorzunehmen, nimmt man die Toggle

Cursor Funktionalität.

• Es stehen zwei Positionsmarken (Cursor) mit zwei verschiedenen Auswertefenstern zur Verfügung.

− Klicken Sie auf       und dieses Fenster erscheint:

• Die Darstellung der Positionsmarken kann mit Tools > Options > Cursor Settings angepasst 

werden.
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Ergebnis der Parameter Analyse (IV)

• Cursor 1 wird mit der linken Maustaste (LMT) gesteuert, Cursor 2 mit der rechten Maustaste (RMT), 

z. B. um die Zeitdifferenz zweier lokaler Maxima einer Kurve zu bestimmen.

Tipp

• Zunächst festlegen, welche Kurve man mit welchem Cursor messen möchte. 

Dazu mit LMT oder RMT auf das Kurvensymbol klicken (in der unteren linke Ecke 

der Kurvenanzeige). Cursor mit RMT oder LMT setzen.

Max Values are:

5.3853 V and 7.5983 V

Time between is:

54.817 ms
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Schlussbemerkungen

• Nachdem man sich mit den Beispielen im Schnellstart auseinandergesetzt hat, sollte man in der Lage 

sein, erste einfache PSpice Simulationen durchführen zu können.

• Dieser Schnellstart ersetzt kein PSpice Training wie es von FlowCAD oder Cadence angeboten wird. 

Es dient nur der Vermittlung von ersten essentiellen Schritten, um einen Einblick in die Möglichkeiten 

von PSpice zu erhalten.

• Sollten benötigte PSpice Modelle nicht in den Standardbibliotheken vorhanden sein, fragen Sie beim 

Hersteller nach. Diese Modelle können über die Simulationseinstellungen im Simulationsprofil mit 

eingebunden werden. Darüber hinaus bietet PSpice auch einen leistungsstarken Model Editor an, mit 

dem man seine eigenen Modelle nur anhand von Datenblättern erstellen kann. 

• Es ist durchaus möglich mit PSpice auch mechanische Simulationen, wie z. B. die eines 

Stoßdämpfers oder eines Fensterhebers durchzuführen. Sie benötigen dazu elektrische 

Ersatzmodelle für diese mechanischen Elemente. Diese sind allerdings nicht Teil der üblichen 

Bibliotheken, die mit der Software von Cadence ausgeliefert werden.

• PSpice unterstützt die Simulationen von Schaltungen, in denen analoge und digitale Signale 

gleichzeitig zu simulieren sind.
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PSpice Erweiterungen

• PSpice ist nicht nur ein analog / digital Simulator, sondern dient auch als Werkzeug um die 

Leistungsfähigkeit, Zuverlässigkeit, Produktivität, Machbarkeit, Kosten und Qualität von Schaltungen 

zu verbessern. Dies geschieht z. B. mittels Einsatz der Empfindlichkeitsanalyse, Parameter Analyse, 

Monte-Carlo Analyse, Langzeit-Zuverlässigkeitsanalyse (Smoke) und durch Optimierung mit der 

PSpice Advanced Analysis Option.

• PSpice erlaubt die Simulation auf Systemebene aufgrund der Eigenschaft die Funktionalität von 

Mikrokontrollern, Mikroprozessoren über abstrakte Modelle in C/C++, SystemC und VerilogA

abzubilden. In Kombination mit der akkuraten analogen und Mixed-Signal Simulation ist es möglich, 

ein gesamtes System inklusive aller Algorithmen in einer Plattform zu simulieren.

• Eine weitere Anwendungsmöglichkeit besteht darin, dass PSpice mit MATLAB verbunden werden 

kann. Cadence stellt einen modifizierbaren Programmieradapter (SLPS, Simulink-PSpice) zur 

Verfügung. Dieser erlaubt eine Co-Simulation mit MATLAB sowie eine Nachverarbeitung von PSpice 

Daten durch MATLAB. Außerdem können MATLAB Block Funktionen in der PSpice Umgebung 

genutzt werden.
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Please do not hesitate to contact us.

Für weitere Fragen und Informationen stehen wir gerne zur Verfügung.

FlowCAD Deutschland

Mozartstr. 2

85622 Feldkirchen bei München

T +49 89 45637-770

info@FlowCAD.de

FlowCAD Schweiz

Hintermättlistr. 1

5506 Mägenwil

T +41 56 485 91 91

info@FlowCAD.ch

FlowCAD Polska

ul. Sąsiedzka 2A

80-298 Gdańsk

T +48 58 727 90 90

info@FlowCAD.pl

Contact us / Kontakt zu FlowCAD 
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Follow Us

Don’t forget to subscribe, share and like! 

twitter.com/

FlowCAD

On FlowCAD’s 

Twitter we provide 

press releases, 

news articles, films 

and images as well 

as reports from 

events.

youtube.com/

FlowCAD

On our YouTube 

channel you can 

find 100+ tutorials 

to learn more about 

electronic circuits. 

Our playlists also 

offer product news 

and webinars.

facebook.com/

FlowCAD

Join our Facebook 

page. You will find 

selected news, 

events, success 

stories and 

insights.

FlowCAD.com/

newsletter

The FlowCAD 

newsletter for PCB 

designers appears 

about every two 

months. It is free 

of cost and will be 

sent by e-mail.

http://www.twitter.com/FlowCAD
http://www.youtube.com/FlowCAD
http://www.facebook.com/FlowCAD
https://news.flowcad.ch/?p=subscribe&id=3
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